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In� this�paper,�we� brieÀy� introduce� the� theory�of� some� descriptive�
and�inferential�statistics�problems,�along�with�basic�commands�for�
data�processing�in�Excel�software.�We�also�present�some�illustrative�
examples� of� calculating� common� characteristic� parameters,�
con¿dence� intervals� for� the�mean� value� of� a� normal� distribution,�
t-test� in� hypothesis� testing� problems,� and� regression� correlation�
problems.�The� e൵ectiveness�of� using� Excel� software� is� illustrated�
by� comparing� the� results� with� theoretical� formulas� and� pocket�
calculators.
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Thông�tin�bài�viết Tóm�tắt

Ngày�nhận�bài:�19/10/2024

Ngày�sửa�bài:�21/11/2024

Ngày�duyệt�đăng:�26/12/2024

Trong�bài�báo�này,�chúng�tôi�giới�thiệu�tóm�tắt�lý�thuyết�về�một�
số�bài�toán�thống�kê�mô�tả�và�thống�kê�suy�luận,�cùng�các�câu�
lệnh�cơ�bản�để�xử�lý�dữ�liệu�trong�phần�mềm�Excel.�Chúng�tôi�
cũng�trình�bày�một�số�ví�dụ�minh�hoạ�về�tính�toán�các�tham�số�
đặc�trưng�thông�dụng,�khoảng�tin�cậy�cho�giá�trị�trung�bình�trong�
phân�phối�chuẩn,�t�–�Test�trong�bài�toán�kiểm�định�giả�thuyết�và�
bài� toán� tương�quan�hồi�quy.�Hiệu�quả�của�việc� sử�dụng�phần�
mềm�Excel�được�minh�hoạ�khi�so�sánh�kết�quả�với�việc�sử�dụng�
công�thức�lý�thuyết�và�máy�tính�bỏ�túi.

Từ�khóa:

Phân�tích�dữ�liệu

Tham�số�đặc�trưng

Khoảng�tin�cậy

Kiểm�định�giả�thuyết

Tương�quan�và�hồi�quy

1. Mở đầu

Xác suất thống kê là một môn học

thuộc ngành toán ứng dụng, trang bị các
khái niệm cơ bản về lý thuyết xác suất và

phân tích thống kê. Môn học này có ứng

dụng rất lớn ở hầu hết các lĩnh vực của

đời sống. Trong nội dung giảng dạy xác

suất thống kê ở hầu hết các trường đại

học, sinh viên mới chỉ được học các công

thức tính và thực hiện tính toán thủ công

bằng máy tính bỏ túi, trong khi thực tế

các dữ liệu thường khá lớn nên việc tính

thủ công sẽ gặp khó khăn, điều đó dẫn
tới nhu cầu sử dụng một phần mềm để

giúp việc xử lý dữ liệu tốt hơn.
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Có rất nhiều phần mềm có thể giúp xử

lý dữ liệu trong thống kê như SPSS, Stata,
R, …, tuy nhiên trong số đó Excel là phần

mềm khá đơn giản, thông dụng với sinh

viên, có khả năng xử lý dữ liệu gần như

chuyên nghiệp.

Thống kê mô tả (Descriptive Statistics)

là các phương pháp dùng để tóm tắt và

mô tả một tập hợp dữ liệu hay một mẫu

nghiên cứu. Nó giúp trình bày các thông

tin quan trọng về dữ liệu, bao gồm các

chỉ số trung bình, phương sai, và phân

phối, từ đó giúp người nghiên cứu hiểu

rõ hơn về những đặc điểm của dữ liệu đó.

Thống kê suy luận (Inferential

Statistics) là một nhánh của thống kê sử

dụng dữ liệu từ mẫu nghiên cứu để rút
ra các kết luận về tổng thể lớn hơn. Nó

giúp các nhà nghiên cứu đưa ra những

giả thuyết và suy luận dựa trên dữ liệu

thu thập được từ mẫu thay vì phải khảo

sát toàn bộ quần thể.

Bài viết sẽ giới thiệu một số tiện ích

được sử dụng trong Excel để giải quyết

các bài toán về thống kê mô tả và thống
kê suy luận. Đặc biệt, chúng tôi đưa ra

các ví dụ thực tế, vừa giải quyết bằng
phương pháp sử dụng công thức và máy

tính bỏ túi, vừa xử lý bằng phần mềm để
bạn đọc thấy rõ hơn tính “ưu việt” của

việc sử dụng phần mềm. Hy vọng rằng,
sẽ giúp cho nội dung giảng dạy môn xác

suất thống kê ở trường đại học thêm

phong phú, cũng như giúp sinh viên giải

quyết được những bài toán gần với thực

tế hơn.

2. Nội dung nghiên cứu

2.1. Hướng dẫn cài đặt tiện ích Data

Analysis trong Excel [1]

- Với Excel 2003, công cụ phân tích dữ

liệu Data Analysis thuộc đơn lệnh Tools.
Nếu trong Tools không thấy công cụ Data

Analysis thì ta phải gọi công cụ này bằng

cách: Nhấp vào Tools → Add - ins

→Analysis ToolPak → OK.

Nếu trong đơn lệnh Tools cũng không

thấy Add - ins, ta phải chạy chương trình

Setup, chọn lệnh Add/Remove , … , rồi

thực hiện các tùy chọn trong hộp thoại.

- Với Excel các phiên bản sau đó

không còn tích hợp sẵn trên menu nữa.
Để kích hoạt tiện ích này ta thực hiện

như sau: Nhấp vào File → Option → Add
- ins → Analysis ToolPak → Go →

Analysis ToolPak → OK. Khi đó, ta vào

đơn lệnh Data sẽ thấy xuất hiện công cụ
Data Analysis.

Hình 1

2.2. Bài toán tính các đặc trưng mẫu

trong thống kê mô tả

2.2.1. Một số tham số đặc trưng thông

dụng [2]

Giả sử ta có bộ dữ liệu thực nghiệm
gồm n phần tử ͳǡݔ) ǡʹݔ ǥǡ ,ሻ݊ݔ khi đó:
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c/ Độ lệch tiêu chuẩn điều chỉnh mẫu:

2ss 

d / Mode là giá trị xuất hiện nhiều nhất

trong tập dữ liệu

e/ Trung vị là giá trị đứng giữa của tập dữ

liệu đã được sắp thứ tự. Khi số quan sát

n là số lẻ thì trung vị là quan sát ở vị trí

thứ
2
1n . Khi n là số chẵn thì trung vị là

trung bình cộng của hai quan sát ở vị trí

chính giữa của tập dữ liệu, tức là hai

quan sát ở vị trí thứ
2
n và

2
2n .

2.2.2. Tính các đặc trưng mẫu bằng công

cụ Data Analysis [3]

Bước 1: Nhập dữ liệu vào trang tính Excel,

sau đó vào Data→ Data Analysis.

Bước 2: Trong hộp thoại Data Analysis
vừa mở, chọn Descriptive Statistics.

Bước 3: Bấm OK.

Hình 2
Bước 4: Trong hộp thoại Descriptive

Statistics, chúng ta sẽ nhập khoảng dữ
liệu, sau đó chúng ta sẽ chọn ô để Excel

xuất kết quả.

Hình 3

Trong hộp thoại Descriptive Statistics,

cần lưu ý các tùy chọn:

- Input Range: là phạm vi đầu vào, cần

chọn biến mà bạn muốn phân tích.

- Grouped By: Chọn cách tổ chức biến

(theo hàng hoặc theo cột).

- Output range: Phạm vi đầu ra.

- New worksheet ply: Kết quả xuất hiện

trong một trang tính mới.

- New workbook: Kết quả xuất hiện

trong sổ làm việc mới.

- Summary statistics: Tùy chọn này sẽ
hiển thị hầu hết các thống kê mô tả.
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- Confidence Level for mean: Khoảng tin

cậy cho giá trị trung bình.

- Kth Largest: Hiển thị giá trị cao nhất

theo mặc định.

- Kth Smallest: Hiển thị giá trị thấp nhất

theo mặc định.

Bước 5: Bấm OK và xem kết quả thu
được.

Cách đọc thông số trên bảng kết quả
(chỉ giới thiệu một số đặc trưng thông

dụng):

- Mean: Giá trị trung bình của tập dữ
liệu.

- Median: Trung vị.

- Mode: hiển thị giá trị xuất hiện nhiều

nhất trong dữ liệu.

- Sample Variance: Phương sai điều

chỉnh mẫu.

- Standard Deviation: Độ lệch tiêu

chuẩn điều chỉnh mẫu.

- Minimum: Hiển thị giá trị nhỏ nhất.

- Maximum: Hiển thị giá trị lớn nhất.

- Sum: Hiển thị tổng tất cả các giá trị.

- Count: Hiển thị kích thước mẫu.

2.2.3. Ví dụ minh họa

Cho dãy số liệu sau: 199, 201, 236, 269,

271, 278, 283, 291, 301, 303, 371. Hãy

tính các đặc trưng của mẫu [4].

Cách 1: Sử dụng công thức và máy tính
bỏ túi

+ Trung bình mẫu: 
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
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i
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1
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+ Phương sai điều chỉnh mẫu:

  
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
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=  227336364,76691
10
11

 = 2378,6

+ Độ lệch tiêu chuẩn điều chỉnh mẫu:

6,2378s = 48,7708

+ Không cóMode

+ Trung vị: 278

Cách 2: Sử dụng đơn lệnh Data Analysis

Sau khi nhập dữ liệu vào bảng Excel.

Trong hộp thoại Descriptive Statistics,
chúng ta sẽ khai báo dữ liệu đầu vào, vị

trí xuất đầu ra, … , cuối cùng ấn OK, ta
sẽ thu được bảng dưới đây:

Hình 4

Nhìn vào bảng trên, ta đọc được các

kết quả như sau: giá trị trung bình mẫu
തݔ ൌ ʹ͹͵Ǣ độ lệch tiêu chuẩn điều chỉnh
mẫu s = 48,7708; trung vị 278; không có

Mode; phương sai điều chỉnh mẫu ʹ̵ݏ ൌ
ʹ͵͹ͺǡ͸Ǣ kích thước mẫu ݊ ൌ ͳͳ.

2.3. Bài toán ước lượng giá trị trung bình

của biến ngẫu nhiên có phân phối chuẩn

2.3.1. Bài toán ước lượng giá trị trung

bình của tổng thể bằng khoảng tin cậy [2]

Bài toán: Giả sử X biến ngẫu nhiên có

phân phối chuẩn ),( 2N với hai tham

số đặc trưng: trung bình tổng thể là 

và phương sai tổng thể ʹߪ . Hãy ước
lượng tham số  bằng phương pháp ước

lượng khoảng tin cậy khi chưa biết
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phương sai, với độ tin cậy ͳ െ ߙ cho

trước.

Bước 1: Dựa vào dữ liệu mẫu, tính các

đặc trưng ssx ,, 2 .

Bước 2: Với độ tin cậy ͳ െ ߙ cho trước:

+ Tìm hai phân vị chuẩn ߙͳെݑ ዁ܿ݋݄ ߙͳെݑ
ʹ

nếu mẫu có kích thước ݊ ൐ ͵ͲǤ

+ Tìm hai phân vị Student

ߙͳെݐ
ሺ݊െͳሻ ዁ܿ݋݄ ߙͳെݐ

ʹ

ሺ݊െͳሻ nếu mẫu có kích thước

30n .

Bước 3: Tìm khoảng tin cậy:

* Khoảng tin cậy đối xứng:





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
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.;. nn t
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n
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Đặt
2

1
. 


 u

n
s

hoặc )1(

2
1

. 


 nt

n
s

 . Khi

đó, ߝ được gọi là độ chính xác của ước
lượng.

Khoảng tin cậy đối xứng có thể viết gọn
lại: തݔ െ Ǣߝ തݔ ൅ ߝ .

* Khoảng tin cậy bên phải:





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


  ;. 1 u

n
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



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n
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* Khoảng tin cậy bên trái:









 1.; u

n
sx ; 








 


)1(

1.; nt
n
sx 

2.3.2. Giải bài toán ước lượng giá trị

trung bình của tổng thể bằng phần mềm

Excel[3]

Bước 1: Nhập dữ liệu vào bảng Excel, sau

đó dùng tiện ích Data Analysis để tính
các đặc trưng mẫu.

Bước 2: Tìm khoảng ước lượng giá trị

trung bình theo công thức: “= trung bình
mẫuേ độ chính xác”.

2.3.3. Ví dụ minh họa

Phỏng vấn 10 gia đình có ba người ở

một huyện vùng cao về chi phí hàng

tháng cho nhu yếu phẩm, thu được số
liệu như sau: 160, 175, 180, 190, 190,

190, 200, 200, 250, 300 (nghìn đồng).
Hãy ước lượng chi phí trung bình hàng

tháng cho nhu yếu phẩm của một hộ gia

đình có ba người ở huyện này với độ tin

cậy 95% [4].

Cách 1: Sử dụng công thức và máy tính

bỏ túi

Dựa vào số liệu mẫu, ta tính được các

đặc trưng:





n

i
ixn

x
1

1
= 203,5

  




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



 



2

1

22 1
1
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i
i

=  25,2035,42942
9
10

 =1700,2777

2344,412777,1700 s .

Với độ tin cậy 95% ta có Ͳǡͻ͹ͷݐ
ͻ ൌ ʹǡʹ͸ʹǤ

4973,29262,2.
10
2344,41. )1(

2
1

 



nt
n
s



Vậy khoảng tin cậy đối xứng của chi phí

trung bình hàng tháng cho nhu yếu
phẩm là:

 4973,295,203;4973,295,203 

)9952,232;0047,174(

Cách 2: Sử dụng đơn lệnh Data Analysis

Sau khi nhập dữ liệu vào trang tính
Excel. Ta gọi tiện ích Data Analysis để xử

lý dữ liệu. Lưu ý rằng: trên cửa sổ
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Descriptive statistics, chúng ta chọn

Summary Statistics. Sau khi chúng ta đã

thực hiện các bước này, chúng ta chọn

confidence interval và chọn mức tin cậy

là 95%. Ở mục chọn ô để Excel xuất kết

quả, chúng ta có thể chọn ô bất kỳ không

trùng đè lên các dữ liệu. Khi đó, ta được
kết quả như sau:

Hình 5

Trên bảng kết quả ta có: തݔ ൌ ʹͲ͵ǡͷǢ
2344,41s . Độ chính xác của ước lượng:

ߝ ൌ ʹͻǡͶͻ͹͵. Vậy khoảng tin cậy cần tìm

là:

 4973,295,203;4973,295,203 

)9952,232;0047,174( .

2.4. Bài toán kiểm định giả thuyết thống

kê giá trị trung bình của tổng thể

2.4.1. Quy trình giải bài toán kiểm định

giả thuyết thống kê về giá trị trung bình
của tổng thể [2]

Bài toán: Giả sử X biến ngẫu nhiên có

phân phối chuẩn ),( 2N với hai tham

số đặc trưng: trung bình tổng thể là 

và phương sai tổng thể ʹߪ . Hãy kiểm

định giả thuyết về giá trị trung bình khi

chưa biết phương sai.

Bước 1: Đặt giả thuyết 00 :  H và

đối thuyết 01 :  H (hoặc 0 

hoặc 0  )

Bước 2: Chọn tiêu chuẩn kiểm định

n
S

XT 
 . Nếu giả thuyết Ͳܪ là

đúng thì tiêu chuẩn kiểm định có dạng

n
S

X
T 0 .

Bước 3: Dựa vào mẫu cụ thể, ta tính các

đặc trưng sx, từ đó tính giá trị quan sát

qsT .

Bước 4: Với mức ý nghĩa ߙ cho trước, tìm

phân vị chuẩn 1u hoặc
2

1 


u nếu

30n ; tìm hai phân vị Student )1(
1



nt 

hoặc )1(

2
1





nt  nếu 30n .

Bước 5: Tìm miền bác bỏ:

- Nếu 01 :  H ta dùng miền bác bỏ

hai phía:














2

1
;  uW U














;

2
1 u .

- Nếݑ 01 :  H ta dùng miền bác bỏ

bên phải:    ;1  uW .

- Nếu 01 :  H ta dùng miền bác bỏ

bên trái:    1; uW .

Lưu ý: trường hợp dùng bảng phân vị

Student ta cũng có các miền bác bỏ

tương tự.

Bước 6: So sánh ݏݍܶ vớiܹߙ rồi rút ra kết

luận:

- Nếu Tqs א Wα thì bác bỏ H0, chấp nhận

H1.



%XL�/LQK�3KXRQJ�9RO�����1R��B'HFHPEHU�����_�S��������

_���

- Nếu Tqs ב Wα thì chưa có cơ sở để bác

bỏ H0, tức là chấp nhận H0.

2.4.2. Giải bài toán kiểm định giả thuyết

về giá trị trung bình của tổng thể bằng
phần mềm Excel [3]

Sau khi đặt giả thuyết và đối thuyết,

nhập dữ liệu vào bảng Excel, tiến hành

theo các bước:

Bước 1: Chọn Data, sau đó chọn Data
Analysis, chọn t – Test: two – sample

Assuming Unequal Variances.

Bước 2: Trong hộp thoại t – Test: two –

sample Assuming Unequal Variances, ta

khai báo vị trí biến chính (Variable 1

range), biến giả (Variable 2 range), giá trị

0 (Hypothesized Mean Difference), mức

ý nghĩa ߙ (Alpha), vị trí đầu ra (Output
range), rồi ấn OK:

Hình 6

Bước 3: Màn hình sẽ trả về bảng kết quả

với các thông tin về trung bình mẫu,

phương sai điều chỉnh mẫu, giá trị quan

sát được của tiêu chuẩn kiểm định và giá

trị miền bác bỏ.

Bước 4: So sánh ݏݍܶ với miền bác bỏ để

rút ra kết luận.

2.4.3. Ví dụ minh họa

Phòng kỹ thuật của một công ty lắp

ráp xe máy theo dõi mức tiêu hao xăng

của một loại xe chạy từ địa điểm A đến
địa điểm B và ghi lại được số liệu như sau:

Mức xăng
tiêu hao (lít) 8,5 9 11 12,5

Số chuyến
tương ứng 5 8 10 2

Bảng 1

Với mức ý nghĩa 5%, có thể kết luận

mức xăng tiêu hao trung bình thấp hơn
11 lít không? Biết mức xăng tiêu hao là

biến ngẫu nhiên tuân theo quy luật phân
phối chuẩn [4].

Cách 1: Sử dụng công thức và máy tính

bỏ túi

Gọi  là mức xăng tiêu hao trung bình

của loại xe này.

Đặt giả thuyết 11:0 H và đối

thuyết 11:1 H .

Chọn tiêu chuẩn kiểm định

n
S

XT 
 , nếu giả thuyết

0H đúng thì tiêu chuẩn kiểm định có

dạng n
S

XT 11
 .

Dựa vào mẫu cụ thể, ta tính các đặc

trưng 31877,1;98,9  sx .

86723,325
31877,1

1198,9



qsT

Với mức ý nghĩa 5% và kích thước mẫu

nhỏ, ta có: Ͳǡͻͻͷݐ
ሺʹͶሻ ൌ ͳǡ͹ͳͳǤ

Vì đối thuyết 11:1 H ta dùng miền

bác bỏ bên trái:ܹߙ ൌ െλǢ െ ͳǡ͹ͳͳ .

Ta thấy ݏݍܶ א ߙܹ nên bác bỏ H0, chấp

nhận ͳܪ . Vậy mức xăng hao phí trung

bình đúng là thấp hơn 11 lít.

Cách 2: Sử dụng đơn lệnh Data Analysis

Bước đặt giả thuyết và đối thuyết, chọn
tiêu chuẩn kiểm định, ta làm như cách 1.
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Chọn Data, sau đó chọn Data Analysis,

rồi chọn t – Test: two – sample Assuming

Unequal Variances.

Trong hộp thoại t – Test: two – sample
Assuming Unequal Variances, ta khai báo

như bảng dưới đây:

Hình 7

Sau khi ấn OK, màn hình sẽ trả về bảng

kết quả như sau:

Hình 8

Nhìn vào bảng ta: ݏݍܶ ൌെ ͵ǡͺ͸͹ʹ͵ .
Vì đối thuyết 11:1 H nên ta chọn

miền bác bỏ bên trái ߙܹ ൌ െλǢ െ
ͳǡ͹ͳͳ . Ta thấy ݏݍܶ א ߙܹ nên bác bỏ

H0, chấp nhận .ͳܪ

2.5. Bài toán tương quan và hồi quy

2.5.1. Hệ số tương quan và phương trình

đường hồi quy tuyến tính

a/ Hệ số tương quan lý thuyết [2]

Giả sử X và Y là hai biến ngẫu nhiên có

phương sai dương. Hệ số tương quan lý
thuyết của hai biến ngẫu nhiên X và Y, kí

hiệu là ሺܺǡߩ ܻሻ , được xác định như sau:

   
)()(

)()(),(
YVXV

YEYXEXEYX 


b/ Hệ sô tương quan mẫu [2]

Hệ số tương quan lý thuyết dùng để
đo mức độ phụ thuộc tuyến tính giữa hai

biến ngẫu nhiên X và Y. Tuy nhiên, nếu

chưa biết phân phối của (X, Y) thì việc

tính hệ số tương quan lý thuyết gặp khó

khăn. Khi đó, hệ số tương quan mẫu

được xem như là một ước lượng của hệ

số tương quan lý thuyết.

Giả sử tiến hành n bước quan sát độc
lập đối với cặp biến ngẫu nhiên (X, Y) ta

có mẫu ngẫu nhiên kích thước n:
ሼ ܺͳǡ ܻͳ ǡ ܺʹǡ ܻʹ ǡǥǡ ܺ݊ǡ ܻ݊ ሽ
Hệ số tương quan mẫu của X và Y, kí hiệu

là r được xác định bởi công thức [5]:

  

    



 








n

i

n

i
ii

n

i
ii

yyxx

yyxx
r

1 1

22

1

c/ Phương trình đường hồi quy tuyến

tính đơn giản [2]

Phương trình đường hồi quy tuyến

tính đơn giản của tổng thể là phương

trình diễn tả giá trị trung bình của biến

phụ thuộc Y theo biến độc lập X đã biết:

Y = A X + B

d/ Phương trình đường hồi quy tuyến

tính mẫu [5]

Phương trình đường hồi quy bình
phương trung bình tuyến tính thực

nghiệm: bxay 
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Với

 

 

 

 






























n

i

n

i
ii

n

i

n

i
i

n

i
iii

x
n

x

yx
n

yx
a

1

2

1

2

1 11

1

1

;

xayb 

2.5.2. Tìm hệ số tương quan và viết
phương tình đường hồi quy bằng phần

mềm Excel

Bước 1: Nhập dữ liệu vào bảng Excel.

Bước 2: Mở tiện ích Data Analysis, sau

đó chọn Regression:

Hình 9

Bước 3: Trong hộp thoại Regression, khai
báo dữ liệu đầu vào (Input Y Range, Input

X range), tên biến (Labels), độ chính xác
(Confidence Lavel), đầu ra (Output range),

rồi ấn OK:

Hình 10

Bước 4: Đọc dữ liệu trong bảng kết quả.

2.5.3. Ví dụ minh họa

Để thực hiện một công trình nghiên

cứu về mối quan hệ giữa chiều cao Y (m)

và đường kính X (cm) của một loại cây,

người ta quan sát trên một mẫu ngẫu

nhiên và có kết quả:

ix 1 3 4 6 8 9 11 14

iy 1 2 4 4 5 7 8 9

Bảng 2

a/ Hãy tính hệ số tương quan mẫu.

b/ Viết phương trình đường hồi quy bình

phương trung bình tuyến tính thực

nghiệm của chiều cao của cây theo

đường kính của nó [4].
Cách 1: Sử dụng công thức và máy tính bỏ túi

a/ Lập bảng tính toán:
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Hình 11

Từ bảng trên ta tính được: 5;7  yx

a/ Hệ số tương quan mẫu là:

  

    



 








8

1

8

1

22

8

1

i i
ii

i
ii

yyxx

yyxx
r

= 9770,0
56.132

84


b/

 

 

 

 






























n

i

n

i
ii

n

i

n

i
i

n

i
iii

x
n

x

yx
n

yx
a

1

2

1

2

1 11

1

1







8
56524

8
40.56364
2

0,6364

5455,07.6364,05  xayb

Phương trình đường hồi quy bình

phương trung bình tuyến tính thực

nghiệm của chiều cao cây và đường kính

của nó là:

5455,06364,0  xbxay

Cách 2: Sử dụng đơn lệnh Data Analysis

Nhập dữ liệu vào bảng Excel (hình 12):

Hình 12

Mở đơn lệnh Data Analysis, sau đó chọn Regression. Trong hộp thoại Regression ta khai

báo dữ liệu: vị trí cột đầu vào, đầu ra, độ chính xác, … , sau đó ấn OK:

Hình 13

Khi đó bảng Excel sẽ xuất hiện bảng kết quả như sau:
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Hình 14

Nhìn vào bảng kết quả, ta thấy 9770,0r và 5455,06364,0  xy .

3. Kết luận

Xác suất thống kê là một môn học có
rất nhiều ứng dụng trong thực tế đặc

biệt là cho các ngành kinh tế, tài chính,

kế toán, … , tuy nhiên trong chương trình

giảng dạy ở trường đại học, môn học Xác

suất thống kê mới chỉ dừng lại ở việc
cung cấp những kiến thức cơ bản nhất về

phân tích thống kê, còn mang nặng tính
lý thuyết và việc sử dụng các kiến thức

này để xử lý dữ liệu trong thực tế còn

khá khó khăn. Bài viết đã giới thiệu tóm

tắt kiến thức lý thuyết về một số bài toán

thống kê mô tả, thống kê suy diễn và các

câu lệnh được sử dụng trong Excel để hỗ

trợ tính toán. Các ví dụ minh họa cho
thấy việc xử lý dữ liệu bằng phần mềm rõ

ràng là đơn giản và nhanh gọn hơn rất
nhiều so với việc tính toán thủ công. Mặc

dù những kiến thức cơ bản về lý xuyết

xác suất và thống kê toán là cần thiết khi
bắt đầu nhập môn về lĩnh vực thống kê

nhưng việc kết hợp bộ công cụ Data
Analysis trong Excel vào môn xác suất

thống kê cũng cho thấy tính hữu ích

không hề nhỏ trong thời đại 4.0. Hy vọng

rằng, việc khai thác chức năng Data

Analysis trong Excel vào giảng dạy xác

suất thống kê sẽ giúp người học dễ tiếp
cận hơn, học hiệu quả hơn và đặc biệt là

bước đầu biết xử lý bộ dữ liệu lớn trong

công tác nghiên cứu và làm việc sau này.
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